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1 Introduction

Batch  Coordinator  is  an  easy  to  use  software  designed  specially  for  effective  image  processing  and

analyses.  It  simplifies  and  automates  image  processing  and  analysis  by  executing  the  specified  and

customized commands on each image within a multiple image data set. 

By applying the specific command sequence to large numbers of images, Batch Coordinator allows benefits

of: 

 Significantly reducing multiple image analysis and processing time

 Increasing reproducibility of repetitive procedures by decreasing risk of inconsistency 

 Facilitating comparison and evaluation of multiple data sets by standardized  output 

 Improving and optimizing overall system utilizations by reducing resource consumption

 Increasing system flexibility and reusability by decoupling the software components
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1.1 Preface

Information in this book is subject to change without notice and does not represent a commitment on the part

of Bitplane AG. Bitplane AG is not liable for errors contained in this book or for incidental  or consequential

damages in connection with the use of this software.

This  document  contains  proprietary  information  protected  by  copyright.  No  part  of  this  document  may  be

reproduced,  translated,  or  transmitted  without  the  expressed  written  permission  of  Bitplane  AG,  Zurich,

Switzerland.

For further questions or suggestions please visit our web site at: 

www.bitplane.com or contact support@bitplane.com.

Bitplane AG
Badenerstrasse 682
8048 Zurich
Switzerland

© November 2008, Bitplane AG, Zurich.
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1.2 Product Overview

Batch Coordinator collects commands, that you might ordinarily issue in Imaris,  into a single batch job and

execute  them  together,  rather  than  entering  each  command  individually  and  processing  each  image

separately. 

Batch Coordinator ensures that image analysis and processing is carried out in exactly the same way, every

time for every single image in a large data set.

The Batch job has four stages:

1. To start Batch processing a command sequence is created in Imaris with adjusted parameter values. By

default,  Batch  commands  will  be  launched  in  Batch  Coordinator  automatically  each  time  they  are

submitted using Imaris. 

2. Selecting images for processing and analysis using Batch Coordinator. Images are placed in an input file

list  and  added  to  the  Processing  Queue.  Output  file  names  and  directory  were  automatically  generated

and placed in the output file list. 

3. Running  Batch  Coordinator,  executing  the  complete  command  sequence  on  selected  input  files  and

collecting results in the output file list. 

4. Reviewing the results either in Imaris or in Excel.

Batch Coordinator Features

The Batch Coordinator has following features:

 Customize and standardize command sequence performed on each input image within a large data set.

 Generate automatically output file directory and names for each Batch job

 Pause, resume, cancel, and obtain the status for any submitted batch and/or any individual job 

 Manage batch job by add or delete commands and fine-tuning parameters values 

 Launch externals applications to inspect input / output data files (i.e. Imaris, or Excel)

 Runs both on Mac and Windows.

Command Sequence

A command sequence can include following commands:

- Flip, rotate, invert, convert, crop Data Set, etc.

- Crop, resample, add / delete, swap channels and time points etc.

- Change the data type, voxel size and time stamps

- Apply a Gaussian or Median filter

- Threshold Adjustment by Baseline and Background Subtraction, Threshold Cut-off, Connective Baseline

- Contrast change by Linear Stretch, Gamma Correction, Normalize Intensity

- Display Adjustment

- Spots and Surfaces analysis with Detection, Tracking and Statistics
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1.3 About this Manual

This manual describes all the features of Batch Coordinator. This User Manual provides a description of all

menu entries, display modes, functions and parameters. The manual is organized into 14 Chapters. 

Chapter  1.  Provides  an  introduction  to  the  Batch  Coordinator.  It  describes  the  function  and  demonstrates

basic capabilities and features of the Batch Coordinator.

Chapter 2. Describes installation procedure, system requirements and licensing options.

Chapter 3. Display Main screen and gives an overall look of the major areas and toolbars.

Chapter 4.  Provides details of  Batch job creation. It  consider the principles in Command sequence design,

with  an  explanation  and  benefits  of  creating  Command  sequence  using  Imaris.  An  example  with

screenshots,  describing  a  procedure  of  creating  Command  sequence  and  executing  a  Batch  job,  is  also

included in this chapter. 

Chapter 5.  Describes Menu File.  Examines techniques for  saving and implementing Command sequences

and considers options allowing the submission and the execution of a Batch job on different machines.

Chapter  6  Contain  information  about  Menu  Edit,  and  describes  creation/deletion  of  Batch  and

addition/removal of batch Files. 

Chapter 7. Gives an overall look of Menu Control and explain how a Batch job can be executed. 

Chapter 8.  Describes Menu Help and presents commands that  display documentation or  other  information

about the Batch Coordinator.

Chapter 9. Describes in details Batch Area and summarize Batch jobs specific elements.

Chapter 10. Discuss frequently used commands presented in Batch Control Toolbars. 

Chapter 11. Describes Command/Parameter area. Defines all commands recognized by Batch Coordinator.

It  provides  guidance  for  parameter  values  modifications  and  emphasizes  importance  of  incorporating  the

correct parameter values. 

Chapter 12. Discusses control shortcuts of Command/Parameter Toolbars used for managing commands in

Command Parameter Area. 

Chapter 13 Provides an explanations of unique features of commands Spots and Surfaces. 

Chapter 14. Describes the output Statistic file. It provides a screenshot example of managing statistical files

after executing Batch job with commands Spots and Surfaces. 
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2 Getting Started

This chapter describes:

Installation

Licence

Starting Batch Coordinator

2.1 Installation

The  software  is  delivered  on  a  standard  CD  or  downloaded  from  www.bitplane.com.  The  CD  includes  a

folder containing the necessary manuals, or the manuals can be downloaded.

Minimum hardware/software requirements are:

 Windows XP, Vista or higher
 Mac OS x10.40 or higher
 CD-ROM
 Network facilities for image import from the microscope
 512 MB RAM (> 1 GB recommended)

Bitplane also recommends:

 A database for storing images (e.g., Image Access) 

Installation

To install the software, please proceed as follows:

 Insert your Batch Coordinator CD-Rom in the computer.
 Follow the instructions on the screen.
 The installation is completed automatically.

2.2 Licensing Options

Batch Coordinator is designed as a high-throughput high-availability software that targets both individuals as

well  as large institutes and corporate.  It  provides the confidence of  high-assurance trustworthy systems,  in

addition  to  the  benefit  of  low-cost  software  support  and  maintenance,  plus  guaranteed  long-term  support

through  participation  from  a  booming  Imaris  community.  The  Imaris  community  benefits  from  frequent

updates, better portability to different computer systems and the ability to directly contribute through software

enhancements and improvements.

Stand Alone

This  licensing  option  allows Batch  Coordinator  to  be  placed on  Mac or  Windows computer  system.  Imaris

does not have to be present and this version of Batch Coordinator does not use or depend on the licenses of

Imaris. Stand alone Batch Coordinator is available in the following configurations: 

- Stand-Alone up to 2 parallel jobs

- Stand-Alone up to 4 parallel jobs

- Stand-Alone up to 8 parallel jobs

- Stand-Alone up to 16 parallel jobs
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- Stand-Alone up to 32 parallel jobs 

Imaris Dependent

This  licensing  option  allows  Imaris  batch  to  be  placed  on  Mac  or  Windows  computer  system,  but  utilizes

licenses of Imaris and its modules as part of its operation. For example, if you want to perform batch job that

require tracking and the output  of  the  statistics  from those  tracks,  this  version  of  Batch  Coordinator  would

use the Imaris, Imaris MeasurementPro, and ImarisTrack licenses. The advantage of this option is that it is

lower  cost than the stand alone version. The Imaris dependent version of Batch Coordinator  comes in  two

configurations: 

- Imaris dependent – up to 2 parallel jobs

- Imaris dependent – up to 4 parallel jobs 

2.3 Starting Batch Coordinator

Starting Batch Coordinator

It is advisable to start the Batch Coordinator either before or concurrently with the Imaris.

To open Batch Coordinator double-click on the Batch Coordinator icon. 

The software opens with the main screen.

Supported File Formats

 Batch Coordinator can read the following file formats, i.e. it can read the image and the parameters.

 Andor: Multi-TIFF series (*.tif, *.tiff)
 Applied Precision, Inc: DeltaVision (*.i3d, *.dv)
 Biorad: MRC-600, MRC-1024 (*.pic)
 BioVision: IPLab Mac (*.ipm)
 Bitplane: Imaris 5.5 (*.ims)
 Bitplane: Imaris 3.0 (*.ims)
 Bitplane: Imaris 2.7 Classic/Old (*.ims)
 Bitplane: Imaris Scene File (*.imx)
 Carl Zeiss: LSM 510 (*.lsm)
 Carl Zeiss: LSM 410, LSM 310 (*.tif, *.tiff)
 Carl Zeiss: Axiovision (*.zvi)
 Image Cytometry Standard: ICS - used by Nikon, Huygens, and others (*.ics, *.ids)
 Leica: TCS-NT (*.tif, *.tiff)
 Leica: LCS (*.lei, *.raw, *.tif, *.tiff)
 Leica: series (*.inf, *.info, *.tif, *.tiff)
 Leica: Image File Format (*.lif)
 Molecular Devices: Metamorph STK (series) (*.stk)
 MRC - primarily electron density volumes as in cryo-EM (*.mrc, *.st, *.rec)
 Olympus: FluoView TIFF (*.tif, *.tiff)
 Olympus: FluoView 1000 OIF (*.oif)
 Olympus: FluoView 1000 OIB (*.oib)
 Olympus: Cell^R 1.1/standard (*.tif, *.tiff)
 Open Microscopy Environment XML (*.ome)
 Open Microscopy Environment TIF (*.tif, *.tiff)
 Perkin Elmer: UltraView (*.tim, *.zpo)
 Scanalytics: IPLab (*.ipl)
 TILL Photonics: TILLvisION (*.rbinf)

Plus it can read general TIFF series (or BMP series).
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3 Main Screen

The main screen in Batch Coordinator provides the facility to build, submit and process batch jobs. It has two

main areas and two Toolbar buttons sections: 

 Batch Area

 Command Parameter Area

 Batch Control Toolbar

 Command Toolbar

From this screen all of the batch component can be accessed, edit and managed. The menu bar at the top of

the window contains the entries: File, Edit, Control and Help.

Each Main screen component is documented in more detail in the following sections.

Batch area 

The central area of the screen is Batch area. Batch area provides detailed specification of Batch. It contains

all  the  information  of  Batch:  Batch  name,  with  input  and  output  files  names,  user  name  and  Batch  status

information.   

Batch Control Toolbar 

Batch Control Toolbar contains shortcut buttons named New Batch, Delete Batch, Add Files, Remove Files,

Run, Stop, Reset.  These shortcuts represent the core tools available to  the user.  The same action can be

accessed via the Menu File, Edit or Control.

Command-Parameter Area

For selected Batch, in the Command -Parameter area all Commands Sequence and commands parameters

with specific Values are displayed. 

Command Toolbar 

The Controls toolbars let you add or delete commands or edit command sequence arrangement by moving

selected commands up and down. 
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4 Batch Creation

Batch  consist  of  Command Sequence  applied  to  selected  input  files  as  a  singe  command  unit,  and  the

results output files,  collected in a newly created image file or statistical  files.  Command sequence contain

the commands with the specified parameters values. A command describes the operation you want execute

on  an  input  dataset  and  specifications  that  a  command  uses  to  perform  its  action  are  called  parameters.

Batch Coordinator offers a variety of available commands for Batch processing, some most frequently used

ones for image processing (Gaussian filter, Threshold adjustment) and some more complex like Surface and

Spot detection.

A Command sequence can be created either using Imaris or directly in Batch Coordinator. 

4.1 Creating a Batch Command Sequence in Imaris

From Imaris commands with Add to Batch button  can be submitted for Batch processing.

Imaris  command  that  can  be  submitted  to  Batch  are  in  Menu  Image  Processing  and  Menu  Edit.  For

Commands Surfaces and Spots, Creation Wizard must be used for selecting and adjusting parameters and

for submitting Tab Creation  . 

Using following procedure, Command sequence is set up in Imaris and submitted to Batch Coordinator.

1. Open an image in Imaris.

2. Select the first command that will be applied to all images.

3. Adjust commands parameters either in Command's window or throughout the Creation Wizard for Spots

and Surfaces. The effect of the modification and parameter adjusting can be seen instantly in the image as

changes are applied.

4. Submit the adjusted command to Batch coordinator by click on Add to Batch button  . 

 Add to batch button is available at the bottom of the command window. 

 For Spots and Surface select Tab Creation and Add to batch button is available at the bottom of

the Tab Creation panel. 

5. Repeat process for series of command that you would like to be execute in Batch Coordinator. 

Note:  Bear  in  mind that  commands are added in  Command Sequence into the Batch  Coordinator  by  the

order they are entered in Imaris. For example, if command Flip and Rotate commands were add to the batch,

the Flip action will be executed first and then the Rotate. So before progressing to the next step make sure

the batch commands are ordered properly and all parameters are confirmed. 

6. The last step is selecting command Save as adding the command Save in Batch command sequence.

7. Open Batch Coordinator.

In  Batch area a New Batch will be created with automatically created User name and Batch Name. A Batch
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Name  always  match  the  name  of  the  first  submitted  Imaris  command  (default  option).  In

command/parameter  area  the  Command  Sequence  will  contain  the  list  of  Imaris  selected  commands

following command Open. The last command in the Command Sequence should be command Save.  

4.2 Creating a Batch Command Sequence in Batch Coordinator

Batch  job  can  be  created  alternatively  in  Batch  coordinator,  rather  than  selecting  commands  from  Imaris.

Select  command  New  Batch  from  Menu  File  or  press  New  Batch  button   and  default  command

sequence is created. In command/parameter window command sequence will contain following commands: 

Open

Save 

To modify  the commands of  New Batch double click on the  command line.  An  arrow appears  indicating  a

drop down window. From a list of commands select a new command. The command sequence is changed in

accordance with a selection. 

Note: In contrast to the command sequence creation by Imaris, creating a command sequence directly by

Batch  Coordinator  sets  parameters  at  default  values.  As  a  result,  parameters  will  not  be  adjusted  and

optimized  to  fit  the  Batch  process  and  analysis  specific  requirements.  Therefore,  it  is  highly  advisable  to

create Batch job with command sequence and adjusted parameters using Imaris. Please refer to the Chapter

 Values for additional reference. 

4.3 Batch job

To complete Batch job input files must be added by clicking on the button Add Input files. All  selected files

will be added to the Input file list and the Output files will be generated automatically and added to the Output

file list.

To initialize a Batch select command Run. The Command sequence will  be executed on the all  input files.

The resulting image and statistical files will be collected and saved in the output file list.

4.4 Example

In this example the compete procedure for setting and executing Batch will be presented. You will start with

creating  the  Command  sequence  containing  commands  Rotate  and  Gaussian  Filter  with  adjusted

parameters in Imaris. Than selection of Input files and the output file list creation will be described, followed

by description of starting a Batch job. The last part will illustrate how the batch resulting files can be reviewed.

 

 

Command Sequence Creation

Open Imaris. In Menu File select command Open. Select image Retina. Press Add to Batch button and than

open the image Retina.

A Retina image is displayed in Imaris Main screen.
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Open Menu Image Processing and select command Rotate. 

A Rotate Channels window will  appear. For Rotation select all  channels along Z axis in Counter Clockwise

orientation. 

Click on Add to Batch button  submits the command into Batch Coordinator. 

Open Menu Image Processing and select command Gaussian filter.  In Gaussian filter  window  select  both

channels and enter 0.2um as a Filter Width value. Click on the Add to Batch button  submits

the command into Batch Coordinator. 

The last step in creating the Command Sequence in Imaris is selecting a commands Save as. Click on the

Add to batch button and command Save added the command Sequence in Batch Coordinator.
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Batch Coordinator

Open a Batch Coordinator .

A New Batch with User Name and Batch Name-Rotate is automatically created and displayed in Batch area. 

 

In  Command  Parameter  area  the  Command  Sequence  is  displayed.  The  command  order  is  the  same  as

commands were selected and submitted in Imaris.

To demonstrate the principle of submitting the parameter values from Imaris to Batch coordinator click on the

(+)  symbol  next  to  the  command  Gaussian  filter.  On  expanded  command  line  all  parameter  values  are

available.  The value for parameter Sigma is set to be 0.2 um as set by Imaris for Filter Width in  Gaussian

filter window. Value for Parameters Channel is on on as filter be applied to both channels.

Input files
The next step in is selecting all  files that will  be processed with created Command sequence. Click on the
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Add files Button  and Choose input files winnow appears.

 

 Select  files  for  Batch  execution  and  click  on  the  Open.  All  selected  files  will  be  added  to  the  Input  list  in

Batch area.

Output Files

The Output  files  names  and  directory  will  be  generated  automatically  and  added  to  the  Output  file  list.  All

output files will be placed in the same directory as the input file, in the new folder, called batch output. The

output files names are created in accordance with the rule of output filename.

Starting Batch Job

To  start  a  Batch  job  select  click  on  the  icon  Run   .  By  Running  Batch  Coordinator,  the  complete

command sequence is executing on all  input files and Batch processing results are collected and stored in

the output file list. In status line massage Queued for all file waiting to be executed. 

 

Completed batch job are marked Finished and remain in the batch display.
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Reviewing results

To verify  results  click  on  the  icon   next  to  a  Retina  output  file.  Imaris  as  externals  applications  will  be

launched processed Retina will be displayed.

   

In addition to opening output Batch files directly in Batch Coordinator, resulting files can be open in Imaris by

selecting and opening Batch file from the file  list.  Open PyramidallCel-BATCH-year-month-day.ims and the

Pyramidal cell image is displayed in the viewing area after the batch processing.
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5 Menu File

The Menu File has the following commands and shortcuts:

New Batch (Ctrl+N or Cmd+N)
New Batch from command Sequence (Ctrl+O or Cmd+O)
Save command sequence (Ctrl+S or Cmd+S)
Import Batch
Export Batch
Exit (Ctrl+ Q or Cmd+Q)

5.1 New Batch

Open the File Menu and then click on the New Batch. Batch structure will be created in Batch area with

automatically created Batch Name-  and user name. In command/parameter window command sequence

will contain following commands: 

Open
Save. 

The same action can be achieved with selecting    New Batch button in the Toolbar

Note:To initialize a Batch job input-files must selected and added.

5.2 New Batch from Command Sequence

To set up a new Batch on an existing Command Sequence select New Batch from command Sequence

in Menu File. The window Open command sequence will appear.

Select a command sequence from the list and click Open or double-click on the requested file entry. 

Creates a new Batch structure in Batch area based on command Sequence already saved.  

Please  refer  to  the  Chapter  Commands  for  more  information  about  organization  and  modification  of

Commands Sequence.

5.3 Save Command Sequence

Save command sequence  saves a current  command sequence with  set  of  parameter  values.  It  provides

the  advantage  of  a  faster  creating  new  Batch  and  the  possibility  of  reusing  standardized  and  complex

Commands Sequences,  therefore saving time and increasing reproducibility of data processing.  

Select option in File Menu Save command sequence. This will open the Save command sequence window.

 

Select the directory and enter the name for the command sequence to be saved or confirm the suggestion.

Click Save.

Command sequence is saved and available to be later used in creating New Batch process.

The default command sequence extension is *. bcx.

5.4 Import Batch

This option allow to rerun the same Batch or to import data from outside your Batch Coordinator system.

Select Import Batch  in Menu File.  An import  Batch window will  appear.  Click Open  or double-click on the
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select Batch from the list. 

A new Batch job is containing command sequence with the input and output file list added to Batch area. 

The default Batch file extension for is *bjx. 

5.5 Export Batch

Export Batch  allows Batch to be saved and letter executed, exchanged with another Batch user or mailed

for a question for the support team. 

Select the Batch you would like to Export. Select Export Batch in Menu File and the Export Batch window

will be open. 

Select the directory and enter the name for the Batch to be exported or confirm the suggestion and then click

 Save. 

The default Batch file extension for is *bjx.

5.6 Exit

Terminates Batch Coordinator.

Note:  Batch  Coordinator  saves  automatically  current  setting  (Command  Sequences  and  files)  even  after

exiting the program.



Imaris Batch

6 Menu Edit

The Menu Edit has the following commands and shortcuts:

New Batch (Ctrl+N or Cmd+N)
Delete Batch
Add Files... (Ctrl+M or Cmd+M)
Remove Files
Select All (Ctrl+A or Cmd+A)
Select None
Preferences (Ctrl+P or Cmd+P)

6.1 New Batch

Open the Edit Menu and then click on the New Batch. Batch structure will be created in Batch area with

automatically created Batch Name-New Batch and user name. In command/parameter window command

sequence will contain following commands: 

Open
Save. 

The same action can be achieved with selecting    New Batch button in the Toolbar.

Note:To initialize a Batch job input-files must selected and added.

6.2 Delete Batch

This option allows deleting selected Batch.

Select Batch to be deleted. The batch will be highlighted in Batch area. 

In Edit Menu select option Delete Batch. Selected Batch will be removed.  

The same action can be achieved with selecting   Delete Batch button in the Toolbar.

6.3 Add Files

To Add files for Batch processing select in Menu Edit  and choose Add Files.  Choose input  files  window

appears. Select the single file to batch or multiple files with ctrl or shift key. All selected files will be added to

the Input list and the output files will be generated automatically and added to the Output file list.

Refer to the Chapter Preference for changing automatic option for defining output name and directory.

The same action can be achieved with selecting    Add Files button in the Toolbar.

To modify the input file  files list click on the line to select file and either press Remove File Button or in Edit

Menu select option Remove File.

Note:  Input  files  added  to  the  Batch  Coordinators  have  properties  defined  by  acquisition.  These  image

properties effect how files could be processed.
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6.4 Remove Files

This option allows deleting selected Files.

Select Batch and within Files to be deleted. The files will be highlighted in Batch area. 

In Edit Menu select option Delete Files. Selected files will be removed from Input and Output columns.  

The same action can be achieved with selecting  Remove Files Button from Batch Toolbar.

6.5 Select All

The Select All command will create a new selection that includes all Batch in Batch Area. 

6.6 Select None

Select None cancels all selections. If nothing is selected, this function will perform no action.

6.7 Preferences

The  Preferences  dialog  allows  you  to  customize  various  settings  and  to  customize  Batch  environment

setting.

Any changes you make to the Batch Preferences settings take effect in image processing.

Batch Agent Path 

The preference option is set in conjunction with Imaris at  the time of installation. It  is advised that  only  the

system administrator has access to it, since any change can have serious effect on the system if incorrectly

set.

Browse

Click Browse to choose the new directory

Number of commands 

Number of commands will verify altered directory of Batch Agent Path. 
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Reload

Data Cache limit (MB): 

Batch Coordinator uses a data caching mechanism that allows you to process images that are significantly

larger than the physical memory (RAM) installed in the computer system. This mechanism writes image data

blocks to the disk and reads them back into the physical memory when they are needed.

Memory Limit (MB)

The value of “data cache” limit controls the amount of data blocks Batch Coordinator will keep in memory at

any time.

Maximum Number of instances 

Default  setting  defined  by  license type  and by  default  is  set  to  be  maximum available  number.  Inserting  a

smaller number limits the numbers of CPU and permitting use of another applications.

Batch setting

Batch Job path

The preference option is set in conjunction with Imaris at  the time of installation. It  is advised that  only  the

system administrator has access to it, since any change can have serious effect on the system if incorrectly

set.

Browse

Click Browse to choose the new directory

Coordinator path

The preference option is set in conjunction with Imaris at  the time of installation. It  is advised that  only  the

system administrator has access to it, since any change can have serious effect on the system if incorrectly

set.

Browse

Click Browse to choose the new directory

Remote address installation 

The preference option is set in conjunction with Imaris at  the time of installation. It  is advised that  only  the

system administrator has access to it, since any change can have serious effect on the system if incorrectly

set.

Default output name

This preference can be adapted and changed by all users. Preferences allow you to define default directory

of output files as well  default  output  file  name.  The default  location is  the input  file  directory.  In  a input  file
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directory, a new folder is created with the name is batch output. The default output file name is created by

input  file  name  with  addition  of  Batch  and  command  name,  date  stamp  and  file  number.  The  output  file

extension is predetermined by the type of  batch file being created. 

<source_path>/batch-output/<source_name>-<batch_name>-<command_name>-<year>-<month>-<day>-<fi

le_no>.<default_ext>

Select option Default Output Name and you can save output file in the directory you specify.

All Output filename will be changed according to the rule user has selected.

Note  Both forward (/)  and backward slashes can be used (\)  and  be  mixed  in  the  same filename without
problems. 

Jobs file name

The preference option is set in conjunction with Imaris at  the time of installation. It  is advised that  only  the

system administrator has access to it, since any change can have serious effect on the system if incorrectly

set.

Browse

Click Browse to choose the new directory

OK button 

To confirm any changes in Preference setting press OK button.

Cancel

If you make changes but decide not to use them, click Cancel. 
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7 Menu Control

The Menu Edit has the following commands and shortcuts:

Run (Ctrl+R or Cmd+R)
Pause (Ctrl+U or Cmd+U)
Stop (Ctrl+T or Cmd+T)
Reset (Ctrl+D or Cmd+D)

The Control commands will be performed on selected entry either files or entire Batch job.

7.1 Run

Start  an  execution  of  batch  process  by  selecting  command  Run  from  Command  Menu.  A  Command

sequence will be executed on all of the input data set files.

The same action can be achieved with selecting  Run Button in Batch Toolbar.

7.2 Pause

Pause a batch process by selecting Pause command in Menu Command. 

When batch is running, it  can be paused by selecting the Pause  command. In Status column Paused with

percentage of finished job will be displayed.

7.3 Stop

When batch  is  running  by  selecting  Stop  in  Menu  Command  an  execution  of  batch  process  is  stopped.

Current running Batch jobs will  be canceled and returned to "un-executed" state.  In Status column Waiting

will be displayed. 

The same action can be achieved with clicking on the Stop button   in Batch Toolbar.  

7.4 Reset

In Menu Command select Reset and finished batch process will be restored to an "un-executed" state. This

option allows modifying Batch job by inserting new commands in command sequence or new input files.

The same action can be achieved with selecting   Reset button in Batch Toolbar.
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8 Menu Help

The Menu Help has the following commands:

User Manual

Bitplane AG

About Batch Coordinator

8.1 User Manual

The  User  Manual  provides  you  with  the  basic  information  about  Batch  Coordinator:  The  menu(s),  the

different Batch Coordinator views and all adjustable parameters in the program. To find a specific parameter

use the "Search function" in the online version of the User Manual.

8.2 Bitplane AG

If  your  computer  is  connected  to  the  Internet,   Batch  Coordinator  can  directly  open  the  Bitplane  AG

homepage (www.bitplane.com).

8.3 About Batch Coordinator
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9 Batch Area

Batch area summarize all information related to Batch jobs. It contains following columns:

Batch Name
User Name
Input file list
Output file list
Status column

9.1 Overview

In Batch Area the hierarchical structure provides information on current and completed batches.

To expand the Batch and display Batch specific details, click the plus symbol (+) next to Batch Name. The

selected Batch is expanded, displaying the batch name, all input and output file names  within the batch, the

name of the user who submitted the batch, and status line. 

Click on the minus symbol () next to Batch name to collapse the content and only Batch and user names will

be displayed. 

Command Sequence of  currently selected Batch is displayed in the Command Parameter area.

9.2 Batch Name

In  the  case  when  Batch  and  Command  sequence  is  created  using  Imaris,  by  default  a  Batch  Name  is

corresponding to the name of first selected command.

In the case when Batch and Command sequence is directly created Batch coordinator using Menu File, Edit

or New Batch button, default option for Batch name is New Batch.

In order to change Batch Name double click on it and enter a new, customized name.

9.3 User

Automatically generated each time when new batch is created by user login session. 

9.4 Input file

Displays the list of all files selected for Batch processing. 

To verify and confirm input file selections double click on the icon  next to file name. It open input files with

Imaris (or standard application) in a new window. 

To remove file from the input file list click on the line to select file and either press Remove File button

or in Edit Menu select option Remove File.

Advance users option

Input files column could be also modified in Command Area. Expend command line Open by clicking on the
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plus  symbol  (+)  next  to  command  name.  Command  is  expended  and  Parameter  File  displays  current  file

name in Value column. 

Input file name or directory could be changed either by:  

1. Entering in the Value column the full path to the new directory along with a new file name, or

2. Double  clicking  open  file  icon  .   Open  File  Window  will  allow  selection  of  new  file  name  or  new

destination folder.

Please refer to the Chapter Commands-Open for additional information about input files. 

9.5 Output File

The Batch Coordinator can generate a variety of different output files and therefore rule must be adopted to

prevent  output  file  names  from  colliding.  Secondly,  in  the  Batch  Coordinator  the  organization  of  creating

output file names differ.

These two issues have combined  resulted in  the sophisticated but  straightforward method in  which  Batch

Coordinator handles the output file names creation. 

Output file column

Displays the list of all pending or created files as a result of Batch processing.

To view and re-examine  the  changes in  output  file  double  click  on  the  icon   next  to  file  name.  It  open

output files by launching external application in a new window.

9.5.1 Output File Names

In Output column file names and directory are automatically generated in accordance with the rule of output

filename. 

Output Files Directory

All output files will be placed in the same directory as the input file, in the new folder, called batch output.

Output File Names

The Output file names generated by using a naming rule comprised of the following: 

By default the output file name is automatically generated from input file name using suffixes batch name,

command name, date stamp and file number.

The output files inherit the input file name as a fist part of output file name. 

The next  part  in  output  file  name will  be  replaced by  the  Batch Name.  Please  refer  to  the  Chapter  Batch

Area-Batch Name for complete details on setting Batch name. 

The next part of the output file name is command name. Only commands linked with the generating output

files  can  appear  as  a  command  name.  Therefore,  only  commands  Save,  Spots  or  Surfaces  (which

generate output files) can appear as a command name in the output file name. Please refer below to Output

file types and formats for more details.

The output  file  name is  determined by  date  stamp,  the  year  (yyyy),  month  (mm) and day  (dd)  of  the  files

added in the Batch in format yyyy-mm-dd, and number of the output files crated. 

User can change value of this column by changing the rule in Menu Edit-Preference, or edit items one by one
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in Command Parameter Area.

Output file types and formats

Output file types and formats depend on the commands specified to be executed in Batch job. Formats the

output files are:

1. Images with extension IMS for Imaris files 

2. Images with extension IMX  for Imaris Scene 

3. Statistical files with the extension CSV for data presented as comma separated values. 

All  files  with  extension  IMS  are  generated  by  command  Save  regardless  of  preceding  commands  in  the

command sequence. The output file name of files with extension ims will contain Save as a command name

in the output file name. 

All  files  with  extension  IMX  and  CSV  are  generated  either  by  command  Spots  or  Surfaces  regardless  of

preceding commands in the command sequence. 

The  output  file  name  of  files  with  extension  IMX  and  CSV  will  contain  Spots  or  Surfaces  as  a  command

name in the output file name. 

All files with extension CSV are statistical files and generated either by command Spots or Surfaces.

Advance users option

 

Files in Output column could be also modified in Command Area. Expend command line Save by clicking on

the plus sign next to command name. Command is expended and Parameter File displays current file name

in Value column. 

Output file name or directory could be changed either by:  

1. Entering in the Value column the full path to the new directory along with a new file name, or

2. Double  clicking  open  file  icon  .   Open  File  Window  will  allow  selection  of  new  file  name  or  new

destination folder. 

Multiple  output  files  (statistical  files  and  Imaris  scene)  can  be  created  by  selecting  commands:  Spots  or

Surfaces.

Please  refer  to  the  Chapter  Statistics  for  additional  information  about  statistical  files  presentation  and

Chapter Commands-Save for output file presentation and arrangement. 

9.6 Status

The Status line displays and reports the full status messages on any batch. 

For unprocessed files in Status line message is Waiting. 

After  starting  a  batch  job  percentage  of  execution  is  displayed  with  bars  indicate  the  amount  of  progress.

When the progress bar reaches 100 percent, file has been successfully processed, all commands executed

and output file saved in the designated folder. Completed batch job are marked Finished and remain in the

batch display.

Unsuccessful batch and job items are marked Crashed and remain in the batch display. 

In status line massage Queued for all file waiting to be executed. 
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10 Batch Control Toolbars

Batch Control Toolbars has following buttons:

New Batch 

Delete Batch 

Add Files 

Remove Files 

Run  

Stop 

Reset

10.1 New Batch

Click on the New Batch icon . Batch structure will be created in Batch area with automatically created

Batch Name Gaussian (default option) and user name. In command/parameter window command sequence
will contain following commands: 

Open 
Gaussian Filter 
Save. 

The same action can be achieved with selecting New Batch command in Menu File or Edit. 

Note:To initialize a Batch job input-files must selected and added.

10.2 Delete Batch

This option allows deleting selected Batch.

Select  Batch  to  be  deleted.  The  batch  will  be  highlighted  in  Batch  area.  Click  on  the   Delete  Batch

button and selected Batch will be removed.  

The same action can be achieved with selecting Delete Batch in the Menu Edit.

10.3 Add Files

To Add files  for  Batch  processing  click  on  the  Add  Files  Button .  Choose input  files  window appears.

Select the single file to batch or multiple files with ctrl or shift key. All selected files will be added to the Input

list and the output files will be generated automatically and added to the Output file list.

The same action can be achieved with selecting Add Files in Menu Edit.  

To remove input file click on the line to select a file and either press Remove File  Button or in Menu

Edit select option Remove File.

Note: Input files added to the Batch Coordinators have properties defined by acquisition conditions and they

affect how files could be processed.
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10.4 Remove Files

This option allows deleting selected Files.

Select Batch and Files to be deleted. The files will be highlighted in Batch area. Click on the Remove Files

button . Selected files will be removed from the Input and the Output file list.  

The same action can be achieved with selecting  option Remove Files in Edit Menu. 

10.5 Run

Start  an  execution  of  batch  process.  Click  on  the  Run  Button   and  a  Command  sequence  will  be

executed on all of the input data set files.

The same action can be achieved with selecting Run from Menu Command.

10.6 Stop

When batch  is  running  by  clicking  on  Stop  button   an  execution  of  batch  process  is  stopped.  Current

running  Batch jobs will  be canceled and returned to  "un-executed"  state.  In  Status  column Waiting  will  be

displayed. 

The same action can be achieved with selecting  Stop from Menu Command.  

10.7 Reset

Click on the Reset  button  and finished batch process will  be restored to  an "un-executed"  state.  This

option allows modifying Batch job by inserting new commands in command sequence or new input files.

The same action can be achieved with selecting Reset in Menu Command. 
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11 Command/Parameter Area

This chapter describes all commands that are recognized by Batch Coordinator. 

Commands could be defined as a set of actions executed on each file in the input file list.  Information and

specifications  that  a  command  uses  to  perform  its  action  are  called  parameters.  In  simple  terms,  the

command is what is done; the parameter is how it does it. 

All commands supported by Batch Coordinator are closely associated with commands in Imaris. 

11.1 Overview

In the Command Parameter Area a Command Sequence of selected Batch is displayed.

A  full  list  of  the  commands  is  accessible  by  double  clicking  on  the  command  line.  Double  click  on  the

command  line  and  an  arrow  appears  indicating  a  drop  down  window  with  a  list  of  all  Batch  Coordinator

available commands names. 

In  Commands  Parameter  Area  the  hierarchical  structure  of  Command  Sequence  provides  information  on

currently selected command. 

To expand the Command sequence, click the (+) symbol next to Command Name. The selected command

line  is  expanded,  displaying  the  all  the  parameters  values  specific  for  selected  command.  Click  on  the  (-)

symbol next to Command name to collapse the content and only Command name is shown.

To change order of Commands in sequence the Up  and Down  buttons of Command/Parameter

Toolbars can be used.

When command is  expanded double click on the Value  column (in  parameter  line)  to  fine-tune  the  values

within the command. 

Note: For each command in the Parameters collection, a Value must be set from a specific list of choices.

Please refer to the Chapter Values for possibilities and risks of modifying command values. 

11.2 Commands

Following Commands are available in Batch Coordinator. 

Open
Save
Flip
Rotate
Channel Shift
Gaussian Filter
Median Filter
Linear Stretch
Gamma Correction
Invert
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Normalize Layers
Baseline Subtraction
Threshold Cutoff
Background Subtraction
Connective Baseline
Display Adjustment
Set Coordinates
Set Time Points
Add Slices
Add Channels
Add Time Points
Delete Slices
Delete Channels
Delete Time Points
Crop 3D
Crop Time
Resample Time
Resample 3D
Change Data Type
Swap Time and Channels
Swap Time and Z
Spots
Surfaces
Matlab
Merge Csv Statistics Post

Please  refer  for  a  more  detailed  description  of  the  commands  and  parameters  to  the  Imaris  Reference

Manual .

11.2.1 Open

By default set to be a first command in command sequence created either by Batch job Creation in Imaris or

directly in Batch Coordinator.

Expend command line Open by clicking on the plus  sign  next  to  command name.  Command is  expended

and Parameter File displays current file name in Value column.

Input file name or directory could be modified either by:

1. Entering in the Value column the full path to the new directory along with a new file name, or

2.  Double  clicking  open  file  icon  .  Open  File  Window  will  allow  selection  of  new  file  name  or  new

destination folder.

To verify and confirm input file double click on the icon  next to file name. It open input files with Imaris

(standard application) in a new window.

11.2.2 Save

In order to save output file from Batch job it  is necessary to include Save as a last command in command

sequence. Command Save is determining extension and part of the file name of the output files.  

All  files  with  extension  IMS  are  generated  by  command  Save  regardless  of  preceding  commands  in  the

command sequence. 

The output  file  name of  files with  extension IMS  will  contain  Save  as  a  command name  in  the  output  file

name. 

Expend command line Save by clicking on the plus sign next to command name. Command is expended and

Parameter File displays current file name in Value column.

Output file name or directory could be changed either by:
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1. Entering in the Value column the full path to the new directory along with a new file name, or

2.  Double  clicking  open  file  icon   .  Open  File  Window  will  allow  selection  of  new  file  name  or  new

destination folder.

To verify and confirm output file double click on the icon  next to file name. It open output files with Imaris

(standard application) in a new window.

11.2.3 Flip

Flip image channels either as a group or individual channels in x, y z direction.

11.2.4 Rotate

Rotates image channels either as a group or separately in Counter Clockwise, Clockwise orientation.

11.2.5 Channel Shift

Allows moving channels relative to one another.

11.2.6 Gaussian filter

The Gaussian filter smoothes the image. The filter value can be applied separately to any of channels or to
all of them.

11.2.7 Median Filter

The  Median  Filter  replaces  the  intensity  of  each  voxel  with  the  statistical  median  of  the  intensities  of

neighboring voxels. The filter value can be applied separately to any of channels or to all of them.

11.2.8 Linear Stretch

Linearly extending image contrast to the new limits. Minimum and Maximum value can be applied separately

to any of channels or to all of them.

11.2.9 Gamma Correction

Intensifying the gray value of a specific range of voxels.

11.2.10 Invert

Inverting all channels individually or all together.

11.2.11 Normalize Layers

Normalize Layers individually or all together.

11.2.12 Baseline Subtraction

Baseline Subtraction subtracts the baseline value from the intensity of  every voxel  in the image. The value

can be applied separately to any of channels or to all of them.

11.2.13 Threshold Cutoff

Threshold compares the intensity of every voxel in the image to the threshold value. The voxel intensity

values below are assigned new intensity, a threshold value new. The Threshold Cutoff values for the

channels may differ.

11.2.14 Background Subtraction

Applies a Gaussian filter to define the background at each voxel and then performs a Baseline Subtraction of

this variable background. The filter value can be applied separately to any of channels or to all of them.
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11.2.15 Connective Baseline

The Connective Baseline works with two, a lower and an upper, threshold values. It applies these thresholds

to divide the image into regions and then processes each region with a Baseline Subtraction using either the

lower or the upper threshold. The threshold values can be applied separately to any of channels or to all of

them.

11.2.16 Display Adjustment

The Display Adjustment manages channel visibility, controls opacity and limits color contrast range.

11.2.17 Set Coordinates

Defines image coordinates.

11.2.18 Set Time Point

Manages file time stamp, modification and last accessed time.

11.2.19 Add Slices

Adding image slices. Data sets must correspond in image dimension, channels and time points.

11.2.20 Add Channels

Adding  channels  extend  or  complete  the  data  set  information.  Data  sets  must  correspond  in  image

dimension, channels and time points.

11.2.21 Add Time points

Adding time points to the data set. Data sets must correspond in image dimension, channels and time points.

11.2.22 Delete Slices

Deletes slices from data set.

11.2.23 Delete Channels

Deletes channels from Data set.

11.2.24 Delete Time Points

Deletes time points from Data set.

11.2.25 Crop 3D

Cropping unwanted parts of an image reducing data set down to the region of interest.

11.2.26 Crop Time

Reducing the total number of time points at the beginning or end of the series of images.

11.2.27 Resample Time

Reducing the total number of time points, displaying the images at a faster speed.

11.2.28 Resample 3D

Reducing the voxel density in a data set, but keeping the original relationship between the voxels.

11.2.29 Change Data Type

Changing data type from current display to 8, 16 or 32 bit.
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11.2.30 Swap Time and Channels

Exchanging the t-axis and the channels and re-formatting the image.

11.2.31 Swap Time and Z

Exchanging the t-axis and the z-axis and re-formatting the image that the time dimension is mapped onto the

z-axis and the z-dimension is mapped onto the t-axis.

11.2.32 Spots

Multiple  step procedure for  automatic  detection of  point-like  structures.  Please refer  to   the  Chapter  Spots

and Surfaces for Batch command more application details and Imaris Reference Manual for Spots Creation

Wizard.

Command Spots is determining extension and part of the file name of the output files.  

All files with extension IMX and CSV are generated by command Spots regardless of preceding commands

in the command sequence. 

The output file  name of  files with  extension IMX and  CSV  will  contain  Spots  as a command name  in  the

output file name. 

11.2.33 Surfaces

Multiple step procedure for automatic detection and creation of artificial solid objects. Please refer to the

Chapter Spots and Surfaces for Batch command more application details and Imaris Reference Manual for

Spots Creation Wizard.

Command Surfaces is determining extension and part of the file name of the output files.  

All  files  with  extension  IMX  and  CSV  are  generated  by  command  Surfaces  regardless  of  preceding

commands in the command sequence. 

The output file name of files with extension IMX and CSV  will contain Surfaces as a command name in the

output file name. 

11.2.34 Matlab

Developing  and  integrating  of  custom  algorithms  specifically  tailored  to  scientific  applications.  A  variety  of

function is offered: Data set, Spot, Filament, Track, Surface, Camera, Stereology functions. Available only for

Windows.

11.2.35 Merge Cvs Statistics Post

Collects all  batch statistical files in to one combined file. Please refer for a more detailed description of the

command to the Chapter Statistics.

11.3 Values

Batch should be able to be run unattended. To obtain correct values for batch processing, it is important to

ensure  that  the  values  are  corresponding  correctly  to  the  image  setting  in  every  regard.  Therefore,  it  is

absolutely  critical  that  values  are  checked in  Imaris.  Test  and  verify  all  command  parameter  values  in  the

Imaris  before  placing  them  in  a  batch  process.  The  simplest  method  of  setting  correct  variables  for  a

command sequence is to open Imaris and create a New Batch with a selected Imaris Command sequence.

Please refer to the Chapter Batch Creation for additional references. 
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Risks and Cautions 

Avoid  editing  batch  commands  values  directly  in  Batch  Coordinator.  In  order  for  the  batch  file  to  work

correctly,  parameters  must  be  set  in  accordance  with  image  acquisition  and  exactly  fitting  processing

and  analysis requirements.  Replacing and adjusting variables directly in a batch file could result  in Batch

job not  execute properly,  as the batch command act  in  accordance with  the parameters entered.  Because

batch process is  operating automatically,  if  parameter  values are used incorrectly,  any command can stop

the process without necessarily giving the user any indication there is a problem. 

Note: Parameter values are case sensitive.
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12 Command/Parameter Toolbars

Bringing  users the control  of  the Command/  Parameter  area.  Use command toolbars to  move up  or  down

commands through a list of commands or to add or delete commands in command sequence. Changes can

be seen directly in the command list.

Up

 Move selected command up in command sequence.

Down 

  Move selected command down in command sequence

Plus 

  Add a new command to existing command sequence.  A new added command by default is Open. 

Minus  

 Remove command from command sequence.

Please refer to the Chapter Commands Value for additional information and advices.



Imaris Batch

13 Spots and Surfaces

The commands Spots and Surfaces have many similarities to other  Batch commands,  but  there are some

distinct  differences  that  need  to  be  taken  into  account  when  creating  Batch  job  containing  the  Command

sequence with commands Spots or Surfaces.

Due to Commands complexity, it is essential to use Imaris Spots and Surfaces Creation Wizard for creating

Batch Commands sequence Spot and Surface.

In Imaris, adjust commands parameters throughout the Creation Wizard for Spots and Surfaces.

The effect of  the modification and parameter  adjusting can be seen instantly  in  the image as changes are

applied. 

Complete Creation Wizard. 

Select Tab Creation  and all parameters values are once more displayed.

Click on Add to Batch button  at the bottom of the Tab Creation panel.

Like  other  commands,  Spot  (or  Surface)  is  added  in  Command  sequence  and  listed  in  the

Command/Parameter area.

Please refer to the Chapter Batch Creation for additional references.

Note: Commands Spots or Surfaces are creating multiple output files from a single input file. 

Two generated output files are: Imaris scene with, extension IMX, and  Statistical file, with extension CSV for

comma-separated values.

Please refer to the Chapter Statistics for additional information about statistical files and Chapter Output File

for output file presentation and arrangement.
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14 Statistics

Files with the CSV (comma separated values) extension are used to save tabular statistical data and can be

opened  by  the  many  spreadsheet  applications(Excel  OpenOffice  Calc).  All  files  with  extension  CSV  are

statistical files and generated either by command Spots or Surfaces.

CSV folder Statistical File Output

For each input file new CSV folder is created within batch output folder. (Refer to the Chapter Output files

for rule for generating output files name and directory). The folder will contain all statistical files created after

executing Batch job, one for each individual statistical variable. Hence, Batch job,  containing the commands

Spots or Surfaces, even for a single input file will produce the multiple output files. As a consequence a large

number of statistical files must be processed and analyzed.

Batch Coordinator provides option for combining multiple CSV statistical files. 

A merger of CSV-files is facilitated by the uniform structure within the individual statistical report folders and

standardized  files  naming.  All  file  names  with  matching  names  of  statistical  variables  (area,  volume,

intensity) are fused together.

Command Merge Csv Statistics Post 

To merge CSV Output  files of  all  jobs within  a Batch,  a  new command must  be inserted into a Command

Sequence.  In  Command/Parameter  Tool  bar  click  on  the  Add  command  Button  .  A  new  command

(Open), appears to be very last command in the Command Sequence. Double click on added command line

and an arrow appears indicating a drop down window. From a list of commands select a command Merge

Csv Statistics Post. 

Command  merge  will  combine  datasets  with  a  common  statistical  variable  and  incorporate  them  in  one

common file containing the specific variable of all input files.

Expand command Merge Csv Statistics Post  by clicking on the (+) symbol. Two parameters are available,

InputFiles and OutputFiles. 
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A  value  for  Input  files  is  automatically  generated  from  individual  statistical  files.  A  value  for  the  merged

Output folder name must be created.

Click on the open file icon   and a new window will be open. Specify the folder name for merged Statistical

CSV  file  and  save  it.  Alternatively,  the  new  directory  and  a  new  file  name  can  be  entered  directly  in  the

parameter OutputFile Value line.

Statistical CSV file name and directory will be written as a value of parameter OutputFile.

Command merge will identify and retrieve from the individual CSV folders all files with the same specific file

name  (all  files  that  share  a  common  statistical  variable  the  same  statistical  variable)  and  merged  in  one

common file. As a result, a new, merged file will be created containing combined specific statistical variables.

The names of new merged files will correspond to names of statistical variables from individual files.

The  resulting  merged  folder  will  have  the  same  number  of  statistical  files  as  the  number  of  calculated

statistical variables.

If  commands  spots  or  surfaces  are  not  present  in  the  Command  Sequence,  Merge  Csv  Statistics  will  be

ignored. 

Excel files

Besides CSV format, statistical data can be also created as XLS file (Excel files).

The following steps are used to change format of statistical file. Please proceed as follows:

In Batch area select Batch containing Command Sequence with commands Spots or Surfaces. 

Expand command Spot (or Surfaces) by clicking on the (+) symbol. 

The type of statistical output files is defined in parameter Statisticswriter and value is set to be by default

bpStatisticsWriterCsv.  

Change value of StatisticWriter parameter from bpStatisticsWriterCsv to bpStatisticsWriterExceXls. 

Note: Parameter values are case sensitive. 

As  a  result,  for  every  input  file  an  Excel  file  will  be  created  and  saved.  The  statistical  variables  will  be

organized in spreadsheets.
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